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Summary
The acoustic ray trace model LYBIN uses a broad set of parameters to accurately calculate the
probability of detecting objects in a given area under water with the use of sonar technology. As
this probability changes with environmental properties, LYBIN rapidly calculates the sonar
coverage. LYBIN has become an important tool in both planning and evaluation of maritime
operations and the software is already integrated in combat system software, tactical decision
aids, and tactical trainers.
LYBIN is a well established and frequently used sonar prediction tool owned by the Norwegian
Defence Logistic Organisation (FLO). It is in operative use by the Norwegian Navy and has been
modified and improved for this purpose for more than 20 years. LYBIN is proven with measurements, and has prediction accuracy similar to other acknowledged acoustical models.
The calculation kernel of LYBIN is implemented as a software module called LybinCom. In
addition there exists a graphical user interface which can be used together with LybinCom to
build a stand-alone executable application. This stand-alone executable application is called
LYBIN.
On behalf of NDLO, the Norwegian Defence Research Institute (FFI) has been responsible for
testing, evaluation and further development of LYBIN since the year 2000. During this period,
several new versions have been released. LYBIN 6.0 was released in august 2009. This document
is a user guide for LYBIN 6.0.
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Sammendrag
LYBIN bruker et bredt spekter av parametre for å gjøre en nøyaktig beregning av sannsynligheten
for å oppdage objekter under vann ved hjelp av sonarteknologi. Når miljøet endrer seg, kan
LYBIN raskt beregne den nye sonardekningen. LYBIN har blitt et viktig verktøy i både
planlegging og evaluering av maritime operasjoner, og programvaren er allerede integrert i
kampsystem, beslutningsverktøy og treningssimulatorer.
LYBIN er et vel etablert og mye brukt sonarprediksjonsverktøy eid av Forsvarets
logistikkorganisasjon (FLO). Det brukes operativt av Sjøforsvaret, og har blitt modifisert og
forbedret for denne type bruk i mer enn 20 år. LYBIN er verifisert mot målinger av
transmisjonstap og gjenklang, og har like god prediksjonsnøyaktighet som andre anerkjente
akustiske modeller.
LYBINs beregningskjerne er implementert som en software modul kalt LybinCom. I tillegg
eksisterer det et grafisk brukergrensesnitt som sammen med LybinCom kan brukes for å bygge en
frittstående eksekverbar applikasjon. Det er denne frittstående applikasjonen som kalles LYBIN.
FFI har på vegne av FLO vært ansvarlig for test, evaluering og videreutvikling av LYBIN siden
2000. I løpet av denne perioden har flere nye versjoner blitt utgitt. LYBIN 6.0 ble utviklet ferdig i
august 2009. Dette dokumentet er en brukermanual for LYBIN 6.0.
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Introduction

The acoustic ray trace model LYBIN is a well established and frequently used range dependent
two-dimensional sonar prediction model owned by the Norwegian Defence Logistic Organisation
(NDLO). A detailed description of the model is given in [1], PART C.
On behalf of NDLO, the Norwegian Defence Research Institute (FFI) has been responsible for
testing, evaluation and further development of LYBIN since the year 2000. During this period,
several new versions of LYBIN have been released. LYBIN 6.0 was released in august 2009.
LYBIN 6.0 consists of a COM module (LybinCom) for the Windows platform and a graphical
user interface (GUI) which can be used together with LybinCom in order to build the stand-alone
executable application. The GUI in LYBIN 6.0 was totally redone; it is programmed in C# and
new functionality regarding range dependence is added.
The COM module, LybinCom, enables LYBIN to interact with other applications, such as
mathematical models, web services, geographical information systems and more. The binary
interface to LybinCom is described in [2]. This document describes the installation and use of the
combined product LYBIN GUI and LybinCom. From here on in the document we call this
constellation LYBIN.
A user guide was written to LYBIN 2.0 in [1], PART A. Descriptions of functionality still present
in LYBIN are partly reused here. The reused parts are printed with approval from the authors at
NDLO and Nansen Environmental and Remote Sensing Center (responsible for implementation
of LYBIN 2.0).
The hardware and software requirements are given in chapter 2 together with detailed installation
instructions. Chapter 3 describes how to start and close LYBIN. The menu and toolbar options are
briefly described in Chapter 4. The various plots are presented in Chapter 5 before a more
thorough description of parameter input via the panes and editors are given in Chapter 6 and 7. At
last, Chapter 8 describes printing.
Two appendices are included. Examples of LYBIN input data model XML are included in
Appendix A. An extension which handles message transmission from LYBIN is described in
Appendix B. This extension can be installed on demand.
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LYBIN – fast and accurate sonar performance prediction

1.1

FFI is responsible for commercial sale, testing, and development of the acoustic ray-trace
software LYBIN.
LYBIN uses a broad set of parameters to accurately calculate the probability of detecting objects
in a given area under water with the use of sonar technology. As this probability changes with
environmental properties, LYBIN rapidly calculates the sonar coverage. LYBIN has become an
important tool in both planning and evaluation of maritime operations and the software is already
integrated in combat system software, tactical decision aids, and tactical trainers.
LYBIN is a well established and frequently used sonar prediction tool owned by the Norwegian
Defence Logistic Organisation (FLO). It is in operative use by the Norwegian Navy and has been
modified and improved for this purpose for more than 20 years. LYBIN is proven with measurements, and has prediction accuracy similar to other acknowledged acoustical models.
On behalf of FLO, FFI has been responsible for testing, evaluation and development of LYBIN
since 2000. During this period, several new versions of LYBIN have been released. LYBIN 6.0
was released in august 2009. Since 2009, FFI is also responsible for commercial sale and support
of LYBIN.
1.1.1

Acoustic Model

LYBIN is a robust, user friendly and fast acoustic ray-trace simulator. Several thousand rays are
simulated traversing the water volume. Upon hitting the sea surface and sea bed, the rays are
reflected and exposed to loss mechanisms. Losses in the water volume itself, due to thermal
absorption are accounted for. LYBIN estimates the probability of detection for a given target,
based on target echo strength, the calculated transmission loss, reverberation and noise. Both
active and passive sonar systems can be simulated.
Range dependent environmental input:









Choices of calculation output:




Bottom type
Bottom topography
Volume back scatter
Sound speed
Temperature
Salinity
Wind speed
Wave height
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Ray trace
Transmission loss
Reverberation (surface, volume and
bottom)
Noise
Signal excess
Probability of detection
Travel time
Impulse response
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Figure 1.1 Snapshot of LYBIN 6.0s graphical user interface. The screen is divided in four
separate parts, one for data input, and three for simulated results. The simulated
results can be altered in any desired position. Ray trace, transmission loss and
probability of detection can be seen on this snapshot.
1.1.2

Software

LYBIN 6.0 can be used both with a graphical user interface, and as a stand-alone calculation
kernel. This duality enables LYBIN to interact with other applications, such as mathematical
models, web services, geographic information systems, and more.
The graphical user interface represents the classical LYBIN application, where LYBIN is used as
stand-alone software. Environmental data and information about the sonar and the sonar platform
are sent to the calculation kernel by the operator through the graphical user interface. Thereafter,
the calculation results are displayed by the graphical user interface.
The stand-alone calculation kernel, called LybinCom 6.0, enhances the potential applicability of
LYBIN by enabling connectivity and communication between systems. LybinCom can be
integrated with external applications, and both input and calculation results can be handled automatically from outside applications. The integration with third parties software can be done
without needing access to LYBINs source code.
LybinCom 6.0 has two different interfaces for data exchange with other software. The two
interfaces are the binary interface and the eXtensible Markup Language (XML) interface. The
binary interface enables fast transportation of large amounts of data to and from LybinCom 6.0.
The XML interface is not as fast, but is more robust because the format of the input files is not as
strict. The XML interface discards any parts of the input file it does not recognize.
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2

Hardware requirements,
software requirements and installation

This section describes the requirements for installing LYBIN 6.0, and the process of actually
installing the software.
2.1

Hardware requirements

This section describes the minimum hardware requirements for running LYBIN 6.0 with
satisfactory user interaction responsiveness.
The minimum hardware requirements are based on the hardware requirements of the software
requirements, described in the next section.



2.2

1 GHz CPU or higher.
512MB RAM or higher.
5 MB free disk space.
Software requirements

All required software, not included in the operating system by default, is listed under software
requirements.




Operating system: Microsoft Windows XP SP3, Vista SP1 or 7
Microsoft .NET 4.0 Framework
Microsoft Visual C++ 2010 Redistributable Package (x86)

LYBIN 6.0 is compatible with 64-bit Windows operating systems. The LybinCom-module can
also be used by other 3rd party software on a 64-bit x86 platform, but only with 32-bit software.
Any interaction with for instance Matlab on a 64-bit platform must be with a 32-bit version of
Matlab.
2.3

Installing LYBIN

LYBIN 6.0 is shipped with two installation files:




LYBIN 6.0 Setup.exe
o Contains prerequisite software not included in the operating system.
o Used if one is uncertain whether the system fulfills the prerequisites.
LYBIN 6.0 Setup.msi
o Contains only the LYBIN software.
o Can be installed only if all prerequisites are met.
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Double-clicking one of the files starts an installation wizard which will lead you through the
installation of LYBIN 6.0.

3

Getting started with LYBIN

Start LYBIN from the shortcut placed in the Program section of the Start menu:
Start --> All Programs --> FFI Applications --> LYBIN 6.0
The initial view when entering LYBIN is displayed in Figure 3.1.

Figure 3.1 The initial view when LYBIN is started. There are four panes: one settings pane on
the upper left, and the other three will display calculation results of choice.

When LYBIN is started, a set of default input parameters are loaded. These can be edited before
the plots are computed, but a calculation can also be started immediately by clicking
or F5.
When parameters have been modified, a calculation has to be started to generate a new plot.
Please note that changes made to the parameters are only kept for the current program run. If the
input parameters set are to be used in later runs, these parameters should be stored in an XML
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file. The parameters can either be stored in an XML file containing all input parameters
(described in Appendix A) or stored in dedicated XML files for each editor (described in Chapter
7).
To quit LYBIN, select Exit from the File menu or click the
button in the screen’s upper right
corner. Before LYBIN exits, a dialogue box is displayed which give the user the possibility to
save the current parameter setting.

Figure 3.2 The dialogue box displayed when LYBIN is exited.
The file with the current parameter setting is stored under the current user:



Windows XP:
C:\Documents and Settings\<user>\Local Settings\Application Data\FFI\LYBIN
Windows Vista and 7: C:\Users\<user>\AppData\Local\FFI\LYBIN

The file is called LybinSavedState.xml, and will be loaded at next start of LYBIN 6.0.

12
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The main screen

When LYBIN is started, the multi-pane main screen appears (see Figure 3.1). This screen is
divided into four panes: one pane for input parameters at the upper left, and three panes dedicated
to display the various plot types. A main menu and a toolbar with icons pointing to functionality
are located in the top of the screen. Figure 4.1 gives a schematic view of the initial main screen.
LYBIN
Main menu
Toolbar
Settings

Environment Plot

Plotype 1

Parameter entry

Plotype 1

Plotype 2

Plotype n...

Plotype 2

Plotype n...

Display plot

Plotype 1

Plotype 2

Display plot

Plotype n...

Display plot

Figure 4.1 A schematic view of the LYBIN main screen.

An alternative main screen is the single pane view. This screen shows only one plot at a time, and
has an area for input above the plotting area.
Both the multi-pane view and single pane view main screen share the main menu and a common
toolbar, and provide the same functionality. The single pane view mode is displayed in Figure
4.2. To access the single pane view pane click
View --> Single Pane View
or click the icon
.
To return to multi-pane view click
View --> Multipane View
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or click the icon

Figure 4.2

.

The single pane view in LYBIN where only one calculation result is displayed.

The rest of this section explains how to work with the different parts of the main screen.
4.1

The Main menu

This section gives an overview of the functions that can be accessed from the Main menu.
References are given to later chapters where functionality needs further explanation.
The Main menu contains the following functions:
File






Print – prints the upper right plot using the selected printer. Refer to chapter 8 for more
information.
Print preview – shows the upper right plot as it will appear when printed. Refer to chapter
Feil! Fant ikke referansekilden. for more information.
Load data model – loads a previously saved complete data model in XML format.
Save data model – saves the active data model in an XML format.
Exit – closes LYBIN.

14
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Edit











Environment – opens the Environment Editor. See section 7.1 for more information.
Wind Speed – opens the Wind Speed Editor. See section 7.1.1 for more information.
Sound Speed – opens the Sound Speed Editor. See section 7.1.2 for more information.
Volume Backscatter – opens the Volume backscattering Editor. See section 7.1.3 for
more information.
Bottom Profile – opens the Bottom profile Editor. See section 0 for more information.
Bottom Type – opens the Bottom Type Editor. See section 7.1.5 for more information.
Bottom Backscatter – opens the Bottom back scattering Editor. See section 7.1.6 for more
information.
Bottom Loss – opens the Bottom Loss Editor. See section 7.1.7 for more information.
Reverberation and noise – opens the Reverberation and noise Editor. See section 7.1.8 for
more information.
Ship, Sonars & Self Noise – opens the Sonar and ship-noise Editor. See section 7.2 for
more information.

NATO RESTRICTED
This function is only visible if the NATO message addin is installed on the computer. See
Appendix B for more information.
 Message – edits a bathy message according to NATO standards.
View




Plot



Help


Multipane View – displays the multi-pane view.
Single Pane View – displays the single pane view.
History All Modes – displays the plot history for all plot types. This display is described
further in section 5.7.

Compute Plots – computes all plots using the currently set parameter values. Chapter 5
describes the plots in detail.
Clear Bottom - clears the existing bottom topography and sets the bottom horizontal, with
a depth equal to the value of the depth scale parameter.

About Lybin – displays a window with information about the current version of LYBIN.
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4.2

The Toolbar

The toolbar contains icons that are shortcuts to important functions in LYBIN. The icons are
shortcuts to the following functions:
Sonar and Ship-noise Editor

Bottom Loss Editor

Environment Editor

Reverberation and Noise Editor

Wind Speed Editor

Volume Back Scattering Editor

Sound Speed Editor

Bottom Back Scattering Editor

Bottom Profile Editor

Compute Plots

Clear Bottom

Toggle between single and multi view

Bottom Type Editor

View History

In addition, the toolbar contains an option to choose between previous plots. A scenario where a
user has plotted five plots is displayed in Figure 4.3. The list box to the left gives an option to
select a plot directly while the user can step through the plots by clicking on the buttons to the
right.

Figure 4.3 Option to choose between previous plots.
4.3

The parameter pane

In multiple view mode, the most frequently changed sonar parameters for the acoustic model are
displayed in the upper left quadrant of the main screen (see Figure 4.4). Ocean and target
parameters, model parameters and display parameters are accessible by selecting one of the other
tabs inside the quadrant. In single view mode the sonar parameters are put in fields above the
plotting area. The other tabs are also accessible from this view mode. Chapter 6 gives a
description of all parameters available in the top left quadrant.
Sonar parameters not present here can be altered via the editor for Sonar Self Noise. This editor
can be accessed by selecting the Sonar and Ship-noise Editor alternative from the Edit menu or

by clicking the
this editor.

icon. Section 7.2 gives a thorough description of how to set parameters in

16
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Figure 4.4 The upper left Sonar parameters tab. This is an easy access to the most commonly
changed parameters.

Shaded or grey input fields indicate that these fields are not valid for input in the set context.
White input fields indicate that these fields are valid for input. Yellow input fields indicate that
the field is still in editing mode and the return key or the tab key has to be pressed to update the
value, see Figure 4.5.

Figure 4.5 Input boxes turn yellow while editing. When the background returns to white, the
changed is accepted.
When a parameter has been modified, the compute button must be clicked or Compute Plots
selected from the Plot menu, to generate a new plot.
Note that the changes made to the sonar parameters are only kept for the current program run. If
the same data is to be used in later program runs, the Sonar Editor must be used to store the sonar
description in a file (see Section 7.2 for more information). An alternative is to save the data
model using Save Data Model from the File menu.
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The settings pane can be changed to display the environment plot, see Figure 4.6. This plot
visualises the environment input parameters set in the Environment Editor described in section
7.1.

Figure 4.6 The environment plot accessed from the main screen. This plot displays the range
dependent environmental properties. On top, the wave height is illustrated as blue
waves. The colouring illustrates the sound velocity, along the profiles drawn with 1
km steps. The bottom profile is coloured by bottom type. Moving the mouse pointer
over any of the colourings will reveal the values of the underlying data.
4.4

Plotting

The computation of plots is controlled by the Compute Plots item on the Plot menu or the icon on
the toolbar
. All available plots, i.e. ray trace, transmission loss, probability of detection,
signal excess and reverberation curves, are computed each time a computation is selected. The
three plot panes can be used to display any of these calculated plots.
The history can be scrolled through by clicking on the arrow buttons in the toolbar, see Figure
4.3. All parameters that were used to compute the currently displayed plot are restored. In this
way, the parameters can be retrieved for a specific case, and editing on these parameters
continued. To display an overview of the last plots generated, click
View --> History All Modes

18
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Section 5.7 describes the History All Modes display, and chapter 5 describes the various plots in
detail.
4.5

Use of context menus throughout the application

Context menus are used throughout the application. These menus are displayed when an object is
right-clicked.
All plots can be copied by right-clicking on a plot and selecting “Copy to Clipboard”. All input
boxes gives context menus with various options for editing.

5

Description of the various plots

This chapter describes how to interpret the plots. The parameters affecting the computation of the
various plots will also be described. There are various locations to alter these parameters. These
locations in the application are listed next to the parameter.
5.1

Ray trace

The ray trace diagram illustrates how the sound propagates from the source. Only rays initiated
within the sonar main lobe is shown. In order to demonstrate typical ray paths, the scattering at
the sea surface is disregarded. An example of a ray trace diagram is shown in Figure 5.1.

Figure 5.1 The ray trace plot displays a defined number of the sound's travel paths. These paths
are calculated based on the sonar parameters and the environment data.

FFI-rapport 11/00205
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5.2

Transmission Loss

The transmission loss plot graphically illustrates the loss of intensity the sound suffers as it travels
within the area spanned by the range and depth axes. Figure 5.2 gives an example of a
transmission loss plot.
Transmission loss may be considered to be the sum of the loss due to spreading and the loss due
to attenuation. Spreading loss is a geometrical effect representing the weakening of a sound signal
as it spreads outwards from the source. Attenuation loss includes the effects of absorption and
scattering. The estimation of the transmission loss is based on intensity computations for a userdefined number of rays.

Figure 5.2 The transmission loss plot displays the loss of intensity due to spreading and
attenuation in a cross-section of the water volume.

Here is a brief overview of the loss mechanisms LYBIN takes into account:




Cylindrical spreading - the intensity loss of a ray segment depends on the horizontal
distance travelled by the ray from the source.
Vertical spreading - given by the vertical density of rays.
Bubble attenuation - wind and breaking waves create a layer of air bubbles near the sea
surface. Sound rays passing through this layer suffer an energy loss depending on the
incoming angle. Small grazing angles imply lengthy paths through the bubble layer and
hence greater losses. The attenuation of the sound is strongly frequency dependent:

20
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negligible at low frequencies, but significant close to the bubble resonance frequency
around 55 kHz.
Bottom loss - is estimated using empirical data for a set of predefined bottom types.
Refer to 7.1.5 for how to set the bottom type. The loss is a function of bottom type and
grazing angle. Predefined angles and corresponding losses are stored in LYBIN.
Thermal absorption - conversion of the elastic energy of a sound wave into heat. This
results in a heating up of the medium. Takes into account boric acid relaxation,
magnesium sulphate relaxation and viscosity.

Scattering – not by itself a loss mechanism, but the results of scattering can be
measured as loss of energy. Unlike several other models which treat scattering as
a loss, LYBIN attempts to simulate the scattering process itself. When a sound ray
hits the surface, it is reflected. Due to ocean waves, the reflection is not
necessarily specular. Scattering refers to the fact that the reflection angle is
somewhat random.

To read the plot, use the colour coding. To determine the transmission loss at an arbitrary position
in the plot, search for the colour of that location in the colour coding. The value of the intensity
loss (dB) is written above this colour.
5.3

Reverberation Curves

The reverberation curves plot graphically illustrates the calculated reverberation from the sea
surface, the water volume, and the sea bottom. The total noise level, calculated from ambient and
self noise, is also included in the plot. The reverberation and noise are plotted in dB/µPa as a
function of distance from the sonar. Noise is shown in green, the surface reverberation in blue, the
volume reverberation in red, the bottom reverberation in brown, and the total masking level is
shown in black. The total masking level is the sum of all reverberation and noise present.
Figure 5.3 gives an example of the reverberation curves plot.
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Figure 5.3 The reverberation curves plot displays the calculated reverberation from the sea
surface (blue), the water volume (red) and the sea bottom (brown). The total noise
level (green), calculated from ambient and self noise, is also included in the plot.
The total of noise and reverberation is included as the black line.

To read the plot, use the colour coding. To determine the reverberation at an arbitrary distance in
the plot, find the distance and locate the curve of interest. The value of the reverberation (dB/µPa)
is read from the axis to the left.
Reverberation and noise levels are estimated differently for the CW (continuous wave) and FM
(frequency modulated) pulses, see section 6.1.1 for more details on the two available pulse types.
The difference lies in the processing gains. In the case of an FM pulse the reverberation and noise
levels are reduced by 10log10(BT), where B is the frequency bandwidth and T is the pulse length,
see section 6.1.1.
5.4

Signal Excess

The signal excess plot graphically illustrates the signal level for a target at any range and depth in
the calculated area. The signal excess is calculated on the basis of target echo strength, calculated
transmission loss, reverberation and noise. An example of a signal excess plot is shown in
Figure 5.4.

22
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Figure 5.4 The signal excess plot displays the remaining part of the signal, after target strength
is added and transmission loss, reverberation, noise and detection threshold is
subtracted, in a cross-section of the water volume .

To read the plot, use the colour coding. To determine the signal excess for an arbitrary position in
the plot, search for the colour of that location in the colour coding. The value of the signal excess
(dB) is written above this colour.
5.5

Probability of Detection

The probability of detection plot graphically illustrates the probability of finding an object
with a given target strength within the area spanned by the range and depth axes. Figure 5.5
gives an example of a probability of detection plot.
The estimation of probability of detection is based on the results from the transmission loss,
noise and reverberation estimation. The sonar equation is used to calculate the signal excess,
and the probability of detection is derived accordingly.
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Figure 5.5 The probability of detection plot displays the probability of detecting a target with a
given echo strength under the given sonar and environmental conditions. It is
assumed a 50 % probability of detection at a signal excess of 0 dB.

To read the plot, use the colour coding. To determine the probability of detection at an
arbitrary position in the plot, search for the colour of that location in the colour coding. The
value of the probability of detection (%) is written above this colour.
5.6

Environment Plot

The environment plot will give the user an overview of the environment parameters used in the
calculation presented in LYBIN. The plot is placed next to the settings tab in the main screen. The
Environment Editor, described in section 7.1, displays the same plot but additionally gives access
to all environmental parameter editors. Figure 5.6 gives an example of an environment plot.

24
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Figure 5.6 The environment plot displays the range dependent environmental properties. On the
top, the wave height is illustrated as blue waves. The colouring illustrates the sound
velocity, along with the profiles drawn with 1 km steps. The bottom profile is
coloured by bottom type. Moving the mouse pointer over any of the colourings will
reveal the values of the underlying data.

The environment plot shows all the environment parameters that will be used in the calculations.
At the top of the plot, waves illustrate the given wind speed or wave height. The height of each
wave corresponds to the value at that range. The sound speed is graphically illustrated with color
codes in the water volume. Red indicates low sound speed, while blue represents high sound
speed. The bottom topography is shown at the bottom of the plot with different shadings in grey
indicating sediment type.
The actual value at each range and depth can be found by holding the mouse cursor over the
environment plot. The position and parameter value are then displayed below the plot, as shown
for the sound speed at range 2394 m and depth 64 m in Figure 5.6.
5.7

Plot History

To display an overview of the last plots generated, click
View --> History All Modes
or click the icon

.

An example with plots for the last 5 calculations is displayed in Figure 5.7.
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Figure 5.7 The history window displays a selected number of previously calculated results.
Which results to display may be changed by the user. The figure displays a screenshot where the user has chosen to display all results and the environment for the last
five calculations.

There are control parameters located at the bottom of the screen:











To remove the index number to the left, uncheck the checkbox Index.
To remove the ray trace plots, uncheck the checkbox Rays.
To remove the transmission loss plots, uncheck the checkbox Tr. Loss.
To remove the signal excess plots, uncheck the checkbox Sig. Exc.
To remove the probability of detection plots, uncheck the checkbox P.o.D.
To remove the reverberation curves plots, uncheck the checkbox Rev.
To remove the environment plots, uncheck the checkbox Env.
To control how many plot calculations to be displayed, select the desired value from the
listbox Plots per screen. The value Fit All will find the best fit for all calculations
performed in a window.
If there are more calculations performed than displayed on the screen, the checkbox
Continue off-screen can be checked to enable scroll-down functionality.
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To go back to one calculation, click
View --> Multipane view/Single Pane view
or click the icon

6

.

Entering parameters from the main screen

This chapter describes the parameters available from the Settings tab on the main screen. For
more detailed description of the parameters and their effects on sonar performance, please refer to
[3]. Parameters can also be entered using the parameters editor.
6.1

Sonar settings

Figure 6.1 The sonar settings available for active sonar contain the most commonly changed
parameters for active sonar. If the sonar is specified with all available modes, the
modes can be selected in the "Mode" selection box. If that is not the case, the user
may check the "Customize" box to freely change any parameters of choice.
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The sonar parameters available for both active and passive sonar are:


Sonar - name of the current sonar. The list of available sonars is displayed by clicking on
the arrow down button to the right.
By default, only the default sonar is available. New sonars can be added either by using
the Sonar Self Noise editor described in section 7.2 or by importing a data model using
the option in the File menu.



Customize – allows the user to quickly set up a customized sonar. When checked, all
sonar parameters displayed here are open for input.



Use Passive Mode – lets LYBIN run computations for passive sonar. When checked,
fields for passive sonar are displayed (see Figure 6.2). The Transmitter part of the
Transmitter/Receiver settings is also locked for input.



Calibration Factor – this parameter is a calibration factor that is not yet implemented but
is displayed on the GUI for future use.



Detection Threshold – the strength of the signal relative to the masking level necessary to
see an object with the sonar. The threshold can range from -100 dB to 100 dB.



System Loss - system loss due to special loss mechanisms in the sea or sonar system not
otherwise accounted for.



Trans. Depth - depth to which the sonar has been lowered. For some sonars the
transducer depth is fixed while it can be adjusted for others. The parameters describing
whether the depth is fixed or in which depth range the sonar is to operate are set in the
Sonar Editor described in section 7.2.3. The field for transducer depth available from the
main screen is therefore dependent on these parameters. The transducer depth ranges
from 0.1 to 12,000 meters



Tilt Angle Transmitter - current angle of the transmitting part of the sonar beam centre,
measured from the horizontal. Positive degrees go upwards and negative downwards
from 90 to -90 degrees.
The parameters describing whether the tilt is fixed or in which tilt range the sonar is to
operate are set in the Sonar Editor described in section 7.2.3. The field for Tilt Angle
available from the main screen is therefore dependent on these parameters.



Tilt Angle Receiver - current angle of the receiving part of the sonar beam centre,
measured from the horizontal. Positive degrees go upwards and negative downwards
from 90 to -90 degrees.
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The parameters describing whether the tilt is fixed or in which tilt range the sonar is to
operate are set in the Sonar Editor described in section 7.2.3. The field for Tilt Angle
available from the main screen is therefore dependent on these parameters.


Beam Width Transmitter - vertical opening of the beam of the transmitting part of the
sonar. For large beam widths the transducer will give a higher dispersal of rays around
the tilt angle. Small beam widths give a higher concentration of rays in the direction
around the tilt angle. The beam width can range from 1-360 degrees.



Beam Width Receiver - vertical opening of the beam of the receiving part of the sonar.
For large beam widths the transducer will give a higher dispersal of rays around the tilt
angle. Small beam widths give a higher concentration of rays in the direction around the
tilt angle. The beam width can range from 1-360 degrees.



Side Lobe Transmitter - difference in intensity levels (in dB) between the main lobe and
the first side lobes, from 5 to 43 dB. This parameter indicates the suppression of the first
side lobe of the transmitting part of the sonar relative to the centre of the beam. High
figures give one-beam-only sonars, whereas low figures give visible side lobes.



Side Lobe Receiver - difference in intensity levels (in dB) between the main lobe and the
first side lobes, from 5 to 43 dB. This parameter indicates the suppression of the first side
lobe of the receiving part of the sonar relative to the centre of the beam. High figures give
one-beam-only sonars, whereas low figures give visible side lobes.

6.1.1

Parameters specific to active sonar

The following parameters are available when Use Passive Mode is unchecked, i.e. for active
sonar:


Mode - name of the current sonar mode. A list of available modes is available by clicking
on the arrow down button to the right of the field. By default, only the defaultmode is
available. New modes can be added by using the Sonar Self Noise editor described in
section 7.2 or by importing a complete data model.



Frequency - operating centre frequency of the sonar.



Source Level - the source level of the sonar with the currently selected mode and
frequency. The source level (in dB) is the output volume of the sonar, and must be in the
range 0 – 500 dB.



Directivity Index - the sonar’s ability to suppress isotropic noise relative to the response
in the steering direction. The directivity index can range from -100 dB to 100 dB.



Pulse - a field describing the pulse form and length for the defined mode.
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Envelope Function - envelope function of the signal. Currently, only “Hann” is available.



Filter Bandwidth – the filter bandwidth of the pulse. The Filter Bandwidth ranges from 0
to 10000 Hz.



FM Bandwidth – frequency modulation bandwidth of the pulse. Applicable for FM
signals only. The FM Bandwidth ranges from 0 to 10000 Hz.



Pulse Form - the pulse form of the currently selected pulse. A list of available pulse
forms is available by clicking on the arrow down button to the right of the field. Valid
values are FM (frequency modulated) and CW (continuous wave). The valid value M is
currently not used.



Pulse Length - the length (in ms) of the currently selected pulse. Valid pulse lengths are
from 0 to 30000 ms.

6.1.2

Parameters specific to passive sonar

Figure 6.2 The sonar settings available for passive sonar contain the most commonly changed
parameters for passive sonar. If the sonar is specified with the correct bandwidth
and integration time, the user may change tilt and frequency. If that is not the case,
the user may check the "Customize" box to freely change any parameters of choice.
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LYBIN can perform calculations also for passive sonar. When the checkbox Use Passive Mode is
checked, passive sonar setting is displayed. The sonar parameters available for passive sonar only
are:

6.2



Type – describes whether the sonar is broad or narrowband. Both choices are available by
clicking on the arrow down button to the right of the field.



Bandwidth – bandwidth for the passive sonar. The Bandwidth ranges from 0 to 10000 Hz.



Frequency – centre frequency for the passive sonar.



Integration Time – integration time for the passive sonar. The valid values range from
0,001 ms to 100 s.
Ocean and Target

Figure 6.3 The ocean and target parameters available for editing.

LYBIN gives the possibility to set various ocean and target parameters prior to calculation as
shown in Figure 6.3.
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6.2.1

Setting target parameters

The ocean and target parameters available are:


Speed – Speed of target relative to own ship. Currently not in use, but is a factor in the
detection of targets in CW-mode using active sonar.



Target Strength – echo which is returned from the target. A value of -15 means that the
intensity reflected from this particular target is 15 dB less than the incoming signal. This
parameter is used in the sonar equation for active sonars.



6.2.2

Source Level – this is the source level of the target. This parameter is only used in
calculations for passive sonars.
Manipulating the miscellaneous parameters



pH – pH level in the sea water.



Ship Density - Density of ship traffic in the area of the calculation. The ship density can
vary from 1 (low) to 7 (high).



Precipitation Noise Type– type of precipitation in the area. The valid values are:
o
o
o
o
o

None
Light Rain
Heavy Rain
Hail
Snow



Ambient Noise Level – noise from ambient sources. If the appurtenant check box is
checked, this parameter will override the internal calculation of ambient noise by LYBIN.



Use Surface Scattering – If checked, the rays hitting the sea surface will be reflected in a
manner simulating sea scattering. The amount of scattering depends on the given
frequency, the sound speed at the surface and the wind speed. If not checked, the rays
hitting the sea surface will be reflected specularly as from a perfectly smooth surface.
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6.2.3

Setting platform parameters

The parameters in the Platform / Own Ship group box are not editable. They only reflect the
parameter settings in the Sonar Self Noise editor described in section 7.2.




6.3

Name – Name of the ship
Self Noise - The ship’s in beam and in band self noise in the direction of the current
simulation.
Self Noise Passive – The ship’s own noise in the direction of the current simulation. This
parameter is used in calculations for passive sonar.
Ship Speed – The current ship speed in knots.
Model Parameters

LYBIN gives the possibility to set various model parameters prior to calculation, as seen in
Figure 6.4.

Figure 6.4 The model parameters available. These parameters control the resolution of the
calculation. If the environmental data has high resolution, the resolution of the
calculations may be increased.


Signal Excess Constant – This parameter can be used to adjust the relation between signal
excess and probability of detection. At the moment, this parameter is not editable in
LYBIN.
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6.3.1

Setting range and depth resolution

The calculation resolution is controlled by the parameters described in this section. The range and
depth scales set here mark the border around the calculation. The calculation results are divided
into calculation cells, and are the basis of the graphical plots in LYBIN.
The internal ray tracing is based on an additional detailing level, called steps. As default, the
number of range steps is 10 times the number of range cells, and the number of depth steps is 20
times the number of depth cells. To avoid too large steps, there is a maximum range step size of
50 meters, and a maximum depth step size of 5 meters. If this step size is exceeded, additional
range steps are added.
The following parameters are available to control range and depth resolution:





Scale – Maximum range or depth in the calculation area.
# Cells – Number of calculation output cells in depth or range.
Cell Size – Size of calculation output cell, given in meters.
# Steps – Number of calculation steps to be used during the internal calculation in
LYBIN.

All these parameters cannot be set independently at the same time. The calculation resolution
would then be over determined. The free parameters help you avoid this. Within each group box
of free parameters (one for range and one for depth), only one combination of parameters can be
chosen. Each alternative opens the appurtenant resolution parameters for editing.
The following combinations of resolution parameters can be set:





6.3.2

Scale and # Cells – Maximum range/depth and a specific number of cells.
Scale and Cell Size - Maximum range/depth and a specific cell size.
Scale and # Steps - Maximum range/depth and a specific number of calculation steps.
Cell Size and # Steps – A specific cell size and a specific number of calculation steps.

Manipulating transmission loss rays

The transmission loss rays are the rays that are used in the calculation of transmission loss, and
thereby form the basis of all the other calculation results in LYBIN. The transmission loss rays
are spread in all directions, according to a density pattern given by the sonar characteristics.
The parameters affecting the transmission loss rays are:




Number of rays – Number of transmission loss rays.
Max boarder hits – Maximum allowed hits at each boarder, e.g. surface and sea bottom.
Termination Intensity – The lowest possible intensity a ray can have before it is
terminated.
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6.3.3

Manipulating visual rays

The visual rays are the rays graphically displayed in the ray trace as seen in Figure 5.1. These
rays are meant to illustrate the rays with the most energy, thus only rays initiated within the sonar
main lobe are shown.
The following parameters are available to manipulate the visual rays:




6.3.4

Number of Rays – Number of visual rays in the ray trace plot.
Max surface Hits – Maximum number of surface hits in the ray trace plot.
Max Bottom Hits – Maximum number of bottom hits in the ray trace plot.

Using calculation switches

In situations where there are multiple choices of how to perform a calculation, or which submodel to use, these choices are made through calculation switches.
The calculation switches available are:




6.4

Rev and noise calculation type – Control the calculation of bottom reverberation values.
There are three possible choices:
o Bottom types – Calculate bottom reverberation from bottom types.
o Bottom back scatter – Calculate bottom reverberation from backscatter values.
o Measured rev and noise – Use measured reverberation and noise data in stead of
calculation.
The last two options require inclusion of additional datasets. How to add Bottom
backscatter data is described in section 7.1.6, and how to include measured reverberation
and noise is described in section 7.1.8.
Use measured bottom loss – Tells LYBIN how to calculate bottom loss. If Use measured
bottom loss is checked, LYBIN will use measured bottom loss value. These must be
added as described in section 7.1.7. If Use measured bottom loss values is not checked,
LYBIN will calculate the bottom loss internally from the given (or default) bottom type.
Display

LYBIN gives the possibility to set various display parameters prior to calculation. The display
parameters control the colouring of plots, step sizes, axis properties and more. The display tab is
seen in Figure 6.5.
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Figure 6.5 The display parameters available. These parameters let the user alter the
presentation of the calculation results without altering the results themselves.

The following display parameters are available:






6.4.1

Use – Controls whether each plot can have its own display parameters, or not. The two
choices are:
o Global display options – Display parameters do not change from one simulation
to the next.
o Separate values per plot – Separate display parameters for each simulation.
Transmission Loss Scale – Change plot colours between multiple colours and greyscale.
Probability of Detection Scale - Change plot colours between multiple colours and
greyscale.
Signal Excess Scale - Change plot colours between multiple colours and greyscale.
Sound Speed Scale - Change plot colours between multiple colours and greyscale.
Visible Area

The parameters in the Visible Area group box control the area displayed in the plots. This area
does not have to be the same as the calculation area. The parameters controlling the visible area
are:



Range – Minimum and maximum plot range.
Depth – Minimum and maximum plot depth.
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6.4.2

Signal Excess Scale

The parameters in the Signal Excess Scale group box control the Signal Excess plot as shown in
Figure 5.4. The parameters are:


6.4.3

Minimum1 - Lowest value of the colour representing the highest signal excess.
Step Size - Range in decibels for each colour.
Transmission Loss Scale

The parameters in the Transmission Loss Scale group box control the Transmission Loss plot as
shown in Figure 5.2. The parameters are:


6.4.4

Minimum – Highest value of the colour representing the lowest transmission loss.
Step Size - Range in decibels for each colour.
Reverberation Scale

The minimum and maximum values of the decibel values in the Reverberation Curves plot are
controlled in the Reverberation Scale group box. The lower value is given to the left and the
higher to the right. The Reverberation Curves plot is shown in Figure 5.3.

7

Entering parameters

While the parameter settings that can be performed via the main screen can be considered as
quick to use and easily accessible, the parameter editors offer in-depth specification of model
parameters. The parameter editors are described below.
LYBIN is able to handle range dependent environments. In LYBIN, range dependent
environmental data is specified for certain range intervals from the sonar.
When the environmental properties are entered for a discrete set of locations (ranges), LYBIN
will create values at intermediate ranges using interpolation. If no environmental descriptions are
given at zero range, LYBIN will substitute the data for the nearest range available, likewise, if
data at maximum range is missing.
Except for BottomProfile and ReverberationAndNoiseMeasurement, the range dependent data are
given with start and stop values to indicate their range of validity. In this context, we call these
datasets, with start and stop related to a value (or a set of values), for range dependent objects. A
range dependent object can contain one or more values with their range of validity. The possible
number of values to be used in the calculation is only limited by the calculation accuracy.
The start and stop functionality provides great flexibility in defining the environmental range
dependent properties. By setting start equal to stop, the data will be considered to belong to a
1

This is actually the maximum value. This will be changed in a future release of LYBIN.
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point in space, and LYBIN will use interpolation to produce data for intermediate ranges points.
The start and stop functionality might be utilized to illustrate meteorological or oceanographic
fronts, entering ranges with finite ranges of validity to each side of the front, and separating the
sets by any small distance, across which the conditions will change as abruptly as the user
intends. In between these two extreme choices, any combination of these can be used.
The user is responsible for ensuring that the ranges of validity do not overlap. If they do overlap,
the behaviour of LYBIN is undefined.
7.1

Environment editor

The environment editor shows all the environmental input in one single plot, as can be seen in
Figure 7.1. The Environment Editor can be invoked by selecting
Edit --> Environment
or by clicking the

icon on the toolbar.

The environmental editor has a big picture displaying all the environmental input parameters in
one single plot. Wind speed is shown by the waves at the top of the picture. Small waves indicate
little wind and larger waves indicate more wind. The sound speed is displayed as colours through
the water volume. The colour bar to the right shows the relation between actual sound speed and
colour. The bottom topography is shown at the bottom of the picture with different shadings of
grey indicating sediment type.
When the mouse is moved over the plot, range and depth are displayed beneath the plot. While
the mouse is moved over the waves at the top of the plot, the wind speed at that range is
displayed. If the mouse is moved inside the water volume, the sound speed at that position is
shown. The bottom type will be displayed if the mouse is moved over the bottom area.
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Figure 7.1 The Environment Editor contains all editors for environmental input data. It also
includes a representation of the most basic profiles, including wind, sound speed,
bottom profile and bottom type.

Each of the environmental parameter types has its own editor. These editors can be opened by
clicking on the buttons in the Open Editor for... group box. The available choices are:


Wind Speed – Opens the Wind Speed Profile Editor. The wind speed is a function of
range. The Wind Speed Profile Editor is described in section 7.1.1.



Sound Speed – Opens the Sound Speed Profile Editor. The sound speed in the water
volume is a function of range and depth. The Sound Speed Profile Editor is described in
section 7.1.2.



Volume Back Scatter – Opens the Volume Back Scatter Profile Editor. The volume back
scatter is a function of range and depth. The Volume Back Scatter Profile Editor is
described in section 7.1.3.



Bottom Profile – Opens the Bottom Profile Editor. The bottom profile is a function of
range. The Bottom Profile Editor is described in section 0.



Bottom Type – Opens the Bottom Type Profile Editor. The bottom type is a function of
range. The Bottom Type Profile Editor is described in section 7.1.5.
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Bottom Back Scatter – Opens the Bottom Back Scatter Profile Editor. The bottom back
scatter is a function of range and gracing angle. The Bottom Back Scatter Profile Editor is
described in section 7.1.6.



Bottom Loss – Opens the Bottom Loss Profile Editor. The bottom loss is a function of
range and gracing angle. The Bottom Loss Profile Editor is described in section 7.1.7.



Reverberation + Noise – Opens the Reverberation And Noise Profile Editor. The
reverberation and noise is a function of range. The Reverberation And Noise Profile
Editor is described in section 7.1.8.

The parameters in the Model Scales group box control the area of the calculation. The parameters
controlling the calculation area are:



Range – Maximal calculation range.
Depth – Maximal calculation depth.

The area of interest may not be the entire calculation area. The user is therefore allowed to zoom
in on areas of particular interest. To open and close this feature, use the Allow Zoom/Normal View
button:



Allow Zoom – Enables the Editable Area group box, and disables the Model Scales group
box.
Normal View – Disables the Editable Area group box, and enables the Model Scales
group box.

The parameters in the Editable Area group box control the area to be seen in the plot in the
Environmental Editor. The parameters are:



Range – Start and end range of visible area in meters.
Depth – Start and end depth of the visible area in meters.

The remaining buttons are global and apply to all the environmental parameters:






Clear Environment – Resets all environmental parameters to default settings.
Open – Opens an environmental file in xml format.
Save – Saves the environmental input parameters to file in xml format.
Ok – Accepts current environmental input parameters and returns to the main screen.
Cancel – Discards changes and returns to the main screen.
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7.1.1

Wind Speed

Wind speed is the strength of the wind at the ocean surface. Strong wind means higher waves and
a larger bubble layer which affects the energy loss near the sea surface, and affects the scattering
of reflected rays. Wind speed values can range from 0-100 m/s.
The Wind Speed Profile Editor can be invoked by selecting
Edit --> Wind Speed
or by clicking the

icon on the toolbar. The editor is displayed in Figure 7.2.

Figure 7.2 The WindSpeed profile editor is based on the common 2-dimentional editor, where
each wind speed value is valid within a range defined by the start and stop values.
The editor contains a table of Wind speed values with their corresponding ranges of validity. Both
the start and stop values specify horizontal distance from the sonar position. If no wind speed is
given, the editor contains the default wind speed. The wind speed table can be edited by tabbing
(pressing the tab key) through the fields in the table. To enter a new data row, click in the next
row or press the tab key from the rightmost field.
LYBIN gives the possibility to save the wind speed input information in an XML file. To save the
wind speed information, click Save beneath the table, find a suitable location for the file and click
Save again. To load an existing set of sound speed information, click Open, select the file and
click Open again.
Click the OK button to accept the current wind speeds and return to main screen. Otherwise, click
the Cancel button to discard changes and return to the main screen.
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7.1.2

Sound Speed

The sound speed in the water volume is a function of both range and depth. Since the sound speed
is most often measured as depth dependent profiles, LYBIN can handle multiple sound speed
profiles with their separate range dependent areas of validity. The dedicated editor is displayed in
Figure 7.3.
The Sound Speed Profile Editor can be invoked by selecting
Edit --> Sound Speed
or by clicking the

icon on the toolbar.

The editor contains a graphical display of the profile to the left, a table of profile values in the
middle and additional information about the profile to the right.

Figure 7.3 The Sound Speed Profile Editor lets the user either manually enter a profile, or
import from a file. The profile is displayed in the plot in the left part of the editor,
while the editable data is presented in the table in the middle of the editor. The
editor also allows for multiple profiles to be entered.
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If no sound speed profile is given, the editor contains the default profile. The default profile
consists of depth, temperature, salinity and sound speed. The user defined profiles, on the other
hand, do not need to contain more than depth and one of the other parameters. If no values are
typed into one or two columns, the valueless columns will be removed when the next row is
entered. Any single profile must have the same parameters throughout, though, i.e. the parameters
included in the first row sets the standard for all the other rows in the profile.
The profile can be edited by tabbing (pressing the tab key) through the fields in the table, see
Figure 7.4. To enter a new data row, click in the next row or press the tab key from the rightmost
field.

Figure 7.4 Editing in the Sound Speed Profile Editor’s table.

To add a new profile for another range, first set the range for the original profile by setting the
fields for Start and Stop. Then click the
icon beneath the table. A new table will now appear.
It can be edited with the same procedure as described earlier. Set the Start and Stop values for this
new profile and push OK. LYBIN will interpolate between any gaps in range. To delete the
current profile, click the
icon beneath the table. To step between the various profiles set over
a distance, use the arrows beneath the table, see Figure 7.5.

Figure 7.5 Stepping between profiles valid at different distances.

In addition to profiles set up in the editor, import of individual profiles in EDF format is possible.
This is a format used in SIPPICANs bathythermographs [4]. To import an EDF file, click the
icon beneath the table. A profile will then be added based on the information in the file. In
addition, the fields for time, latitude and longitude to the right in the editor will be set
automatically. The user must specify start and stop values for the profile.
LYBIN gives the possibility to save the total sound speed input information in an XML file. To
save the sound speed information, click Save beneath the profile’s graphical display, find a
suitable location for the file and click Save again. To load an existing set of sound speed
information, click Open, select the file and click Open again.
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7.1.3

Volume Backscatter

Volume backscatter is the fraction of energy scattered back towards the receiver from the sea
volume. Scattering elements in the sea volume can be particles or organic life, like plankton, fish
or sea mammals. The volume backscatter is not distributed uniformly in the sea, and can vary
considerably as a function of depth, and also on range and time of the day. In LYBIN, the volume
backscatter is given as a profile of backscattering coefficients as a function of depth. To find
scatter values for the depths not given, linear interpolation is used. The validity range of each
profile will be given by the corresponding start range and stop range values.

The VolumeBackScatter Profile Editor can be invoked by selecting
Edit --> Volume Backscatter
or by clicking the

icon on the toolbar.

The input of volume backscatter consists of three input windows: the first where the profile is
defined, a second where volume backscatter tables are associated over a distance, and a third
where sample profiles are defined for each table. Figure 7.6 gives an overview of how they are
related, and the three windows are displayed in Figure 7.7.

Figure 7.6 The relationship between windows for volume backscatter input.

The first entry point, the Volume Back Scatter Profile Editor, gives the possibility to save the total
volume backscatter input information in an XML file. To save the volume backscatter
information, click Save at the bottom left, find a suitable location for the file and click Save again.
To load an existing set of volume backscatter information, click Open, select the file and click
Open again.
To enter the information manually, click inside the field named “(Collection)”. A button will then
be displayed to the right. Click this button and the next editor, the Volume Back Scatter Table
Collection Editor, will appear.
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Figure 7.7 The volume backscatter input windows are based on the common 3-dimentional
editor, where an array of values is valid for a defined range defined by the start and
stop values.

The Volume Back Scatter Table Collection Editor gives the possibility to set volume backscatter
for several steps in range. To fill in the backscatter profile, click inside the field named
“(Collection)”. A button will then be displayed to the right. Click this button and the next editor,
the Volume Back Scatter Sample Collection Editor, will appear. Edit backscatter by editing in the
values to the right. If more values are to be added, click Add beneath the members list. If values
are to be removed, click Remove beneath the members list. Click OK when all values are set.
If several depth profiles are to be set over a distance, the Volume Back Scatter Table Collection
Editor provides the functionality to achieve this. Edit the range values for an existing depth
profile by editing the values for Start and Stop to the right. Add a new depth profile for another
range by clicking Add beneath the members list. If depth profiles are to be removed, click
Remove beneath the members list. Click OK when all depth profiles are included.
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7.1.4

Bottom Profile

The bottom profile editor can be invoked by selecting
Edit --> Bottom Profile

or by clicking the icon

on the toolbar. The editor is displayed in Figure 7.8.

Figure 7.8 The Bottom Profile Editor lets the user create, load, alter and save a bottom profile.
The vertices of the profile, displayed as circles, may be altered using the mouse
pointer.

The parameters in the Model Scales group box control the area of the calculation. The parameters
controlling the calculation area are:



Range – Maximal calculation range.
Depth – Maximal calculation depth.
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The area of interest may not be the entire calculation area. The user is therefore allowed to zoom
in on areas of particular interest. To open and close this feature, push the Allow Zoom/Normal
View button:



Allow Zoom – Enables the Editable Area group box, and disables the Model Scales group
box.
Normal View – Disables the Editable Area group box, and enables the Model Scales
group box.

The parameters in the Editable Area group box control the area to be seen in the plot in the
Bottom Profile Editor. The parameters are:



Range – Start and end range of visible area in meters.
Depth – Start and end depth of the visible area in meters.

In order to optimize the calculation area according to the water volume of interest, there are two
options available:



Adjust Scale – adjust the maximum calculation depth to the lowest bottom point. . This
function does not consider not-yet-accepted changes.
Clear Bottom - removes all points and sets the bottom as a straight line coinciding with
the bottom line of the view.

To save the bottom profile information to an XML file, click Save to the bottom left, find a
suitable location for the file and click Save again. To load an existing set of bottom profile
information, click Open, select the file and click Open again.
Bottom depths can also be inserted manually. Move the cursor to the desired co-ordinate and
click the left mouse button to insert a new point in the bottom profile. Each time a point has been
set, the editor draws a smooth path between the existing points. The physical location of the
cursor is shown below the view. Clicking the left mouse button on or near an existing point lets
the user change the location of this point. Clicking the right mouse button on or near one of the
registered points will remove it from the profile. Clicking the right mouse button anywhere else in
the plot reveals a context menu with the option to copy to clipboard.
When the mouse is moved over the plot, range and depth are displayed beneath the plot. The
bottom type will also be displayed if the mouse is moved over the bottom area.
Click the OK button to accept the current bottom topography and returns to main screen.
Otherwise, click the Cancel button to discard changes and return to the main screen.
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7.1.5

Bottom Type

The geo-acoustic properties of the bottom can be coded by a single parameter in LYBIN: the
bottom type. Bottom types range from 1 to 9, where 1 represents a hard rock type of bottom with
low bottom reflection loss, while 9 represents a soft bottom with a high reflection loss. The
bottom types 1-9 are FNWC bottom provinces as described in [5]. In addition, bottom types 0 and
10 have been added, representing no loss and fully absorbing bottoms, respectively. Bottom type
is the default way to describe sea floor acoustical properties in LYBIN.
The Bottom Type Profile Editor can be invoked by selecting
Edit --> Bottom Type
or by clicking the

icon on the toolbar. The editor is displayed in Figure 7.9.

Figure 7.9 The BottomType profile editor is based on the common 2-dimentional editor, where
each bottom type value is valid within a range defined by the start and stop values.

The editor contains a table of bottom type values with their corresponding ranges of validity.
Both the start and stop values specify horizontal distance from the sonar position. If no bottom
type is given, the editor contains the default bottom type. The bottom type table can be edited by
tabbing (pressing the tab key) through the fields in the table. To enter a new data row, click in the
next row or press the tab key from the rightmost field.
LYBIN gives the possibility to save the bottom type input information in an XML file. To save
the bottom type information, click Save beneath the table, find a suitable location for the file and
click Save again. To load an existing set of sound speed information, click Open, select the file
and click Open again.
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Click the OK button to accept the current bottom type and return to main screen. Otherwise, click
the Cancel button to discard changes and return to the main screen.
7.1.6

Bottom Backscatter

Bottom backscatter is the fraction of energy that is scattered back towards to the receiver when a
ray hits the sea bottom. The bottom backscatter is a function of sediment type, grazing angle and
frequency. A dataset representing bottom backscatter coefficients is entered into LYBIN in
tabular form, giving backscattering coefficients (in dB) for a set of grazing angles. Based on the
tabulated values, LYBIN interpolates between tabulated values to create backscatter coefficients
for equidistantly spaced grazing angles. The backscatter coefficients are given as dB per square
meter.
Bottom backscatter is an alternate way to calculate bottom reverberation. LYBIN will only use
the bottom backscatter values given if Rev and noise calculation type is set to Bottom Back
Scatter as described in section 6.3.4.
The Bottom Back Scatter Profile Editor can be invoked by selecting
Edit --> Bottom Backscatter
or by clicking the

icon on the toolbar.

The input of bottom backscatter consists of three input windows: the first where the profile is
defined, a second where bottom backscatter tables are associated over a distance and a third
where sample profiles are defined for each table. The three windows are displayed Figure 7.10.
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Figure 7.10 The bottom backscatter input windows are based on the common 3-dimentional
editor, where an array of values is valid for a defined range defined by the start and
stop values.

The first entry point, the Bottom Back Scatter Profile Editor, gives the possibility to save the total
bottom backscatter input information in an XML file. To save the bottom backscatter information,
click Save at the bottom left, find a suitable location for the file and click Save again. To load an
existing set of bottom back scatter information, click Open, select the file and click Open again.
To enter the information manually, click inside the field named “(Collection)”. A button will then
be displayed to the right. Click this button and the next editor, the Bottom Back Scatter Table
Collection Editor, will appear.
The Bottom Back Scatter Table Collection Editor gives the possibility to set bottom backscatter
for several steps in range. To fill in the profile, click inside the field named “(Collection)”. A
button will then be displayed to the right. Click this button and the next editor, the Bottom Back
Scatter Sample Collection Editor, will appear. Edit backscatter by editing in the values to the
right. If more values are to be added, click Add beneath the members list. If values are to be
removed, click Remove beneath the members list. Click OK when all values are set.
If several profiles are to be set over a distance, the Bottom Back Scatter Table Collection Editor
provides the functionality to achieve this. Edit the range values for an existing profile by editing
the values for Start and Stop to the right. Add a new profile for another range by clicking Add
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beneath the members list. If profiles are to be removed, click Remove beneath the members list.
Click OK when all profiles are included.
7.1.7

Bottom Loss

Bottom loss is the fraction of energy that is lost when the sound is reflected from the ocean
bottom, usually expressed in dB. The bottom loss is also referred to as forward scattering in
underwater acoustic terminology. Bottom loss is generally a function of sediment type, gracing
angle and frequency. A dataset representing bottom loss is entered into LYBIN in tabular form,
giving bottom loss (in dB) for a set of grazing angles. Based on the tabulated values, LYBIN
interpolates to create loss values for equidistantly spaced grazing angles.
The use of bottom loss values is optional in LYBIN. The checkbox Use measured bottom loss
(see section 6.3.4) located in the tab for Model Parameters, tells LYBIN to use the given bottom
loss values instead of calculating them from the specified bottom type.
The Bottom Loss Profile Editor can be invoked by selecting
Edit --> Bottom Loss
or by clicking the

icon on the toolbar.

The input of bottom loss consists of three input windows: the first where the loss profile is
defined, a second where bottom loss tables are associated over a distance and a third where
sample loss profiles are defined for each table. The three windows are displayed in Figure 7.11.
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Figure 7.11 The bottom loss input windows are based on the common 3-dimentional editor,
where an array of values is valid for a defined range defined by the start and stop
values.

The first entry point, the Bottom Loss Profile Editor, gives the possibility to save the total bottom
loss input information in an XML file. To save the bottom loss information, click Save at the
bottom left, find a suitable location for the file and click Save again. To load an existing set of
bottom loss information, click Open, select the file and click Open again.
To enter the information manually, click inside the field named “(Collection)”. A button will then
be displayed to the right. Click this button and the next editor, the Bottom Loss Table Collection
Editor, will appear.
The Bottom Loss Table Collection Editor gives the possibility to set bottom loss for several steps
in range. To fill values in the table, click inside the field named “(Collection)”. A button will then
be displayed to the right. Click this button and the next editor, the Bottom Loss Sample Collection
Editor, will appear. Edit bottom loss by editing in the values to the right. If more values are to be
added, click Add beneath the members list. If values are to be removed, click Remove beneath the
members list. Click OK when all values are set.
If several loss tables are to be set over a distance, the Bottom Loss Table Collection Editor
provides the functionality to achieve this. Edit the range values for an existing loss table by
editing the values for Start and Stop to the right. Add a new loss table for another range by

52

FFI-rapport 11/00205

clicking Add beneath the members list. If tables are to be removed, click Remove beneath the
members list. Click OK when all loss tables are included.
7.1.8

Reverberation and Noise

In some cases, one has measurements of reverberation and noise, and would like to use these
directly in the calculation of signal excess and probability of detection. LYBIN has the possibility
to incorporate these measurements in the calculations. Reverberation and noise input values can
consist of any number of measurements with corresponding ranges. To find values for the ranges
not given as measurements, LYBIN uses linear interpolation.
Reverberation and noise input is an alternative where one uses measured values instead of letting
LYBIN estimate reverberation and noise. LYBIN will only use the reverberation and noise input
values if Rev and noise calculation type is set to Measured rev and noise as described in section
6.3.4.
The Reverberation And Noise Profile Editor can be invoked by selecting
Edit --> Reverberation and noise
or by clicking the

icon on the toolbar. The editor is displayed in Figure 7.12.

Figure 7.12 The ReverberationAndNoise profile editor is based on the 2-dimentional editor,
where each reverberation and noise value is valid for a single position. The value
represents a vertex on the envelope of the curve of reverberation and noise.

The editor contains a table of reverberation and noise values with their corresponding distances
from the sonar. To enter a new data row, click in the next row or press the tab key from the
rightmost field.
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LYBIN gives the possibility to save the reverberation and noise input information as an XML
file. To save the reverberation and noise information, click Save beneath the table, find a suitable
location for the file and click Save again. To load an existing set of reverberation and noise
information, click Open, select the file and click Open again.
Click the OK button to accept the current reverberation and noise and return to main screen.
Otherwise, click the Cancel button to discard changes and return to the main screen.
7.2

Ship, Sonars, and Self Noise

The Sonar Self Noise window displays ship parameters given in the Ship Editor (see section
7.2.2) and the Sonar Editor (see section 7.2.3).
The Sonar Self Noise window can be invoked by selecting
Edit --> Ship, Sonars & Self Noise
or by clicking the

icon on the toolbar. The window is shown in Figure 7.13.

The editable values in this window – frequency, transducer depth, ship speed, and relative bearing
– only affect the noise levels shown in this window. The values used in calculations can be set in
the Ship Editor, Sonar Editor, or Sonar Settings tab, as appropriate.
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Figure 7.13 The Sonar Self Noise window contains a graphical presentation of the ship self
noise. The window also contains buttons to open editors for the ship and sonar
parameters.
The following parameters are displayed in the Sonar Self Noise window:
7.2.1.1 Ship




Name - the name of the ship.
Type - type or class of ship, for instance “frigate”.
Edit Ship button – opens the Ship Editor.

7.2.1.2 Sonar


Sonar name – name or type of the sonar

7.2.1.3 Sonar Settings



Frequency - the frequency (in kHz) for which the noise level is shown.
Transducer Depth - the transducer depth (in m) for which the noise level is shown.
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7.2.1.4 Other parameters affecting Noise




Wind Speed – Wind speed in m/s.
Ship Speed - the ship speed, in knots, for which the noise level is shown.
Relative bearing - the direction (relative to the ship) for which the noise level is shown.
Given in degrees.

7.2.1.5 Noise levels at sonar frequency



7.2.2

Ship Noise – the ship’s in beam and in band self noise at the specified frequency,
transducer depth, speed, and relative bearing.
Ambient noise – Ambient noise from external sources.
Total Noise – Ship and ambient noise combined.
Edit Ship

The ship editor contains all the relevant information about the platform holding the sonar. The
platform is most often a ship, but can also be a helicopter or a buoy.
The Ship Editor can be invoked by selecting the Edit Ship button in the Sonar Self Noise window.
The editor is shown in Figure 7.14.

Figure 7.14 The Ship Editor lets the user inspect, alter or create the ship parameters. It is the
ship noise profile for various speeds, frequencies and sonar depths that is used in
calculations.
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Ship parameters include:







Ship name - the name of the ship.
Ship Type - type or class of ship, for instance “fregatt”.
Course - the ship’s course, in degrees, relative to North.
Speed - the ship’s current speed, in knots.
Latitude- the ship’s current latitude, in decimal degrees. North is defined positive.
Longitude - the ship’s current longitude, in decimal degrees. East is defined positive.

Ship Noise data consist of measurements that can be given for a user-defined number of
frequencies, ship speeds and sectors (relative bearings). For each of these combinations, the noise
measured at different depths can be registered. Use the Num Sectors to set the correct number of
sectors of ship noise measurements. The sectors are assumed evenly distributed around the ship,
so if you have measurements for every 10 degrees, you should set the number of sectors to 36.
Additional information about the noise measurements can be given in the following fields:






Ship name - the ship on which the measurements were done; not necessarily the same as
the current ship.
Sonar type - name of sonar type used to perform the measurements.
Date - date of measurements.
Latitude- the ship’s latitude during measurement, in decimal degrees. North is defined
positive.
Longitude - the ship’s longitude during measurement, in decimal degrees. East is defined
positive.

Several sonars can be associated to a ship. Select the current sonar and use the Edit Sonar button
to invoke the sonar editor where data for each sonar can be entered (see Section 7.2.3). The part
of the Ship Editor that associates sonars to the ship is shown in Figure 7.15.

Figure 7.15 Step between the sonars associated with the ship and use the Edit Sonar button to
invoke the sonar editor.

You can save the ship data as a file by pressing the Save button, find a suitable location for the
file and click Save again. To load an existing set of ship data, click Open, select the file and click
Open again. Data about the sonars attached to the ship is also stored together with the ship data,
so that the next time you load a ship, all of its associated sonars are loaded also.
Click OK to accept changes and return to the sonar self noise editor, or Cancel to discard changes.
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7.2.3

Edit Sonar

The Sonar Editor is the editor where one in detail defines parameters for a new sonar. The Sonar
Editor can be invoked by selecting the Edit Sonar button in the Sonar Self Noise window, or by
selecting the Edit Sonar button in the Ship Editor Window. The editor is shown in Figure 7.16.

Figure 7.16 The Sonar Editor lets the user view and alter the sonar parameters. The user may
also use the editor to create new sonar parameter profiles. By creating a complete
sonar parameter file for multiple sonar modes, user experience on a day-to-day
basis will be increased.
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The following commands are available:






Open - lets the user open a previously saved sonar file. All sonar parameters will be
loaded.
Save - lets the user save all parameters for the current sonar as an XML sonar file. Note
that this will save the sonar data to a separate XML file. If you want to attach it to a ship,
you have to use the Save button in the ship editor (see Section 7.2.2).
OK - uses the defined parameters as data for the current sonar.
Cancel - discards the changes.

Sonar parameters include:


Sonar Name - the type of the sonar.



Depth Fixed - indicates whether the sonar has a variable transducer depth or a fixed
transducer depth ( i.e. hull mounted sonars).
Depth - the fixed depth for fixed-depth sonars. The current depth for variable depth
sonars. All depths are in meters.
Limits - the minimum and maximum depth of a variable depth sonar.
















Tilt Fixed - indicates whether the sonar has variable tilt angle or a fixed tilt angle.
Tilt transmitter - the fixed tilt angle for fixed-tilt sonars. The current tilt for variable tilt
sonars. Tilts are measured in degrees, positive angles are defined upwards.
Tilt receiver - the fixed tilt angle for fixed-tilt sonars. The current tilt for variable tilt
sonars. Tilts are measured in degrees, positive angles are defined upwards.
Min (down) - the negative (downward) tilt limit for variable tilt sonars.
Max (up) - the positive (upward) tilt limit for variable tilt sonars.
Sidelobe transmitter - the vertical sidelobe suppression of the transmitter. The sidelobe
suppression indicates the suppression (in dB) of the first sidelobe of the sonar relative to
the centre of the beam. High figures give one-beam-only sonars, whereas low figures give
visible sidelobes.
Sidelobe receiver - the vertical sidelobe suppression of the receiver. The sidelobe
suppression indicates the suppression (in dB) of the first sidelobe of the sonar relative to
the centre of the beam. High figures give one-beam-only sonars, whereas low figures give
visible sidelobes.
Beam width transmitter - indicates the vertical beam width (in degrees) of the transmitter
beam.
Beam width receiver - indicates the vertical beam width (in degrees) of the receiver beam.
Rel. Bearing - Indicates the direction (relative to the ship) at which the transducer is
currently pointing. Given in degrees.
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Calib.Factor - the calibration factor (in dB) gives an opportunity to correct for systematic
errors in the Probability of Detection calculations for a certain sonar. It should be set to 0
until evidence shows errors in the PoD calculations.
Detec.Threshold - the detection threshold (in dB) for this sonar. The detection threshold
is the strength of the signal necessary to see an object on the sonar.
System loss- is given in dB and subtracted from signal excess before calculation of
probability of detection starts.

Some parameters are specific for passive sonar calculations. These are:


Narrowband / Broadband – type of sonar.



Bandwidth – The bandwidth of the sonar.



Integration Time – Integration time during passive mode.

A sonar can have different source levels and directivity indices for a set of frequencies
and modes. These can be edited using the following buttons:







Freq - the current frequency (in kHz).
o Use the plus sign to select the number of frequencies on this sonar.
o Use the arrows to select which frequency is currently in use.
o Use the cross to delete a frequency.
Mode - name of the current mode.
o Use the plus sign to select the number of modes on this sonar.
o Use the arrows to select which mode is currently in use.
o Use the cross to delete a mode.
Directivity Index - is the beam pattern’s ability to suppress isotropic noise relative to the
response in the steering direction.
Source Level - the source level of the sonar with the currently selected mode and
frequency. The source level (in dB) is the output volume of the sonar.

A sonar can have a number of different pulse types. In LYBIN several pulses can be
defined, and the parameters for them are edited using the following buttons:









Use the plus sign to select the number of pulses.
Use the arrows to select which pulse is currently in use.
Use the cross to delete a pulse.
Envelope Function - the Envelope Function for the currently selected pulse.
Pulse Form - pulse form of the currently selected pulse. The pulse form can be selected
by pressing the arrow down button to get a list of the available pulse forms, which are
CW, FM and M at present.
Pulse Length - The length (in ms) of the currently selected pulse.
Filter Bandwidth - The filter bandwidth (in Hz) of the currently selected pulse.
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FM Bandwidth - The FM modulation bandwidth (in Hz) of the currently selected pulse.
Note that this value is only applicable to FM pulses. The field will be grayed out if any of
the other pulse forms are selected.

Things to note:


Data about sonars can be stored in separate files, but to attach them to a ship you
have to first start the ship editor (see section 7.2) and then launch the Sonar Editor
from there. When you have finished editing sonar parameters, press the Ok button
and go back to the ship editor where you save all the ship’s data, including the
sonar(s), on a ship file by pressing the Save button. In this way, the sonar(s) you
have defined will be loaded with the ship every time LYBIN is run.



Saving sonar data on a separate file is useful if you are going to attach the same
sonar to several ships. Then you can load its definition from the sonar file for each
ship, and avoid retyping the same parameters repeatedly.

8

Results

LYBIN 6.0 has functionality for printing the calculation plots. The functionality is found under
the File-menu, as Print… and Print preview.
Both options print the calculation result displayed in the upper right window within LYBIN in
multi-view mode. When in single view mode, the displayed result is printed.
The print preview functionality can be used for displaying how the selected calculation result will
appear printed on paper.
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Figure 8.1 Screen-shot of the print preview window. The picture displays how the calculated
ray trace will appear on an A4 page.
The print functionality will print the calculation results on a printer of choice.
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Appendix A

LYBIN XML format v3.0

This section contains supplementary material describing file format of LYBIN xml files.
A.1

The default complete modell

<?xml version="1.0" encoding="utf-8"?>
<LYBINFILE xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<FILEINFO>
<FORMATVERSION>3.00</FORMATVERSION>
</FILEINFO>
<MODELFILE>
<MODELPARAMETERS>
<BOTTOMREVERBERATIONCALCULATION>true</BOTTOMREVERBERATIONCALCULATION>
<DEPTHCELLS>50</DEPTHCELLS>
<DEPTHCELLSIZE>6</DEPTHCELLSIZE>
<DEPTHSCALE>300</DEPTHSCALE>
<DEPTHSTEPS>1000</DEPTHSTEPS>
<DEPTHSTEPSIZE>0.3</DEPTHSTEPSIZE>
<IMPULSERESPONSECALCULATION>false</IMPULSERESPONSECALCULATION>
<IMPULSERESPONSEDEPTH>0</IMPULSERESPONSEDEPTH>
<MAXBORDERHITS>5000</MAXBORDERHITS>
<NOISECALCULATION>true</NOISECALCULATION>
<PASSIVECALCULATION>false</PASSIVECALCULATION>
<PROBABILITYOFDETECTIONCALCULATION>true</PROBABILITYOFDETECTIONCALCULATION>
<RANGECELLS>50</RANGECELLS>
<RANGECELLSIZE>200</RANGECELLSIZE>
<RANGESCALE>10000</RANGESCALE>
<RANGESTEPS>500</RANGESTEPS>
<RANGESTEPSIZE>20</RANGESTEPSIZE>
<RAYTRACECALCULATION>true</RAYTRACECALCULATION>
<SIGNALEXCESSCALCULATION>true</SIGNALEXCESSCALCULATION>
<SIGNALEXCESSCONSTANT>3</SIGNALEXCESSCONSTANT>
<SURFACEREVERBERATIONCALCULATION>true</SURFACEREVERBERATIONCALCULATION>
<TERMINATIONINTENSITY>1E-16</TERMINATIONINTENSITY>
<TRANSMISSIONLOSSFROMTARGETCALCULATION>true</TRANSMISSIONLOSSFROMTARGETCALCULATION>
<TRANSMISSIONLOSSTOTARGETCALCULATION>true</TRANSMISSIONLOSSTOTARGETCALCULATION>
<TRAVELTIMEANGLERESOLUTION>1</TRAVELTIMEANGLERESOLUTION>
<TRAVELTIMECALCULATION>false</TRAVELTIMECALCULATION>
<TRLRAYS>1000</TRLRAYS>
<TYPEOFREVNOISECALCULATION>0</TYPEOFREVNOISECALCULATION>
<USEMEASUREDBOTTOMLOSS>false</USEMEASUREDBOTTOMLOSS>
<USEWAVEHEIGHT>false</USEWAVEHEIGHT>
<VISUALBOTTOMHITS>1</VISUALBOTTOMHITS>
<VISUALNUMRAYS>50</VISUALNUMRAYS>
<VISUALRAYTRACECALCULATION>true</VISUALRAYTRACECALCULATION>
<VISUALSURFACEHITS>2</VISUALSURFACEHITS>
<VOLUMEREVERBERATIONCALCULATION>true</VOLUMEREVERBERATIONCALCULATION>
</MODELPARAMETERS>
<PLATFORMFILE>
<PLATFORMNAME />
<PLATFORMTYPE />
<LATITUDE>60.1</LATITUDE>
<LONGITUDE>4.4</LONGITUDE>
<COURSE>0</COURSE>
<SELFNOISE>50</SELFNOISE>
<SELFNOISEPASSIVE>50</SELFNOISEPASSIVE>
<SPEED>10</SPEED>
<SENSORFILE>
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<BEAMWIDTHRECEIVER>15</BEAMWIDTHRECEIVER>
<BEAMWIDTHTRANSMITTER>15</BEAMWIDTHTRANSMITTER>
<CALIBRATIONFACTOR>0</CALIBRATIONFACTOR>
<DEPTH>5</DEPTH>
<DETECTIONTHRESHOLD>10</DETECTIONTHRESHOLD>
<DIRECTIVITYINDEX>1</DIRECTIVITYINDEX>
<FREQUENCY>7000</FREQUENCY>
<INTEGRATIONTIMEPASSIVE>1</INTEGRATIONTIMEPASSIVE>
<PASSIVEBANDWIDTH>100</PASSIVEBANDWIDTH>
<PASSIVEFREQUENCY>800</PASSIVEFREQUENCY>
<SIDELOBERECEIVER>13</SIDELOBERECEIVER>
<SIDELOBETRANSMITTER>13</SIDELOBETRANSMITTER>
<SONARTYPEPASSIVE>0</SONARTYPEPASSIVE>
<SOURCELEVEL>221</SOURCELEVEL>
<SOURCELEVELPASSIVE>150</SOURCELEVELPASSIVE>
<SYSTEMLOSS>0</SYSTEMLOSS>
<TILTRECEIVER>4</TILTRECEIVER>
<TILTTRANSMITTER>4</TILTTRANSMITTER>
<PULSE>
<ENVELOPEFUNC>Hann</ENVELOPEFUNC>
<FILTERBANDWIDTH>100</FILTERBANDWIDTH>
<FMBANDWIDTH>100</FMBANDWIDTH>
<FORM>FM</FORM>
<LENGTH>60</LENGTH>
</PULSE>
</SENSORFILE>
</PLATFORMFILE>
<ENVIRONMENTFILE>
<BOTTOMFILE>
<BOTTOMPROFILE>
<RANGE>0</RANGE>
<DEPTH>280</DEPTH>
</BOTTOMPROFILE>
</BOTTOMFILE>
<BOTTOMTYPEFILE>
<BOTTOMTYPE>
<START>0</START>
<STOP>0</STOP>
<TYPE>4</TYPE>
</BOTTOMTYPE>
</BOTTOMTYPEFILE>
<OCEANFILE>
<AMBIENTNOISELEVEL>50</AMBIENTNOISELEVEL>
<PH>8</PH>
<PRECIPITATIONNOISETYPE>0</PRECIPITATIONNOISETYPE>
<SHIPDENSITY>4</SHIPDENSITY>
<SOURCELEVELTARGET>10</SOURCELEVELTARGET>
<SURFACESCATTERFLAG>true</SURFACESCATTERFLAG>
<TARGETSPEED>10</TARGETSPEED>
<TARGETSTRENGTH>10</TARGETSTRENGTH>
</OCEANFILE>
<SOUNDSPEEDFILE>
<SOUNDSPEEDPROFILE>
<START>0</START>
<STOP>0</STOP>
<PROFILE>
<DEPTH>0</DEPTH>
<TEMPERATURE>7.36366126149536</TEMPERATURE>
<SALINITY>35</SALINITY>
<SOUNDVELOCITY>1480</SOUNDVELOCITY>
</PROFILE>
</SOUNDSPEEDPROFILE>
</SOUNDSPEEDFILE>
<VOLUMEBACKSCATTERFILE>
<VOLUMEBACKSCATTER>
<START>0</START>
<STOP>0</STOP>
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<SCATTERDENOM>DB</SCATTERDENOM>
<VOLUMESCATTER>
<DEPTH>0</DEPTH>
<SCATTER>-92</SCATTER>
</VOLUMESCATTER>
</VOLUMEBACKSCATTER>
</VOLUMEBACKSCATTERFILE>
<WINDFILE>
<WIND>
<START>0</START>
<STOP>0</STOP>
<WINDSPEED>0</WINDSPEED>
</WIND>
</WINDFILE>
</ENVIRONMENTFILE>
</MODELFILE>
</LYBINFILE>

A.2

Wind Speed XML format

<?xml version="1.0" encoding="utf-8"?>
<WINDFILE xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<FILEINFO>
<FORMATVERSION>3.00</FORMATVERSION>
</FILEINFO>
<WIND>
<START>0</START>
<STOP>5000</STOP>
<WINDSPEED>6</WINDSPEED>
</WIND>
<WIND>
<START>5000</START>
<STOP>10000</STOP>
<WINDSPEED>8</WINDSPEED>
</WIND>
</WINDFILE>

A.3

Sound Speed XML format

<?xml version="1.0" encoding="utf-8"?>
<SOUNDSPEEDFILE xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<FILEINFO>
<FORMATVERSION>3.00</FORMATVERSION>
</FILEINFO>
<SOUNDSPEEDPROFILE>
<START>0</START>
<STOP>3500</STOP>
<PROFILE>
<DEPTH>0</DEPTH>
<TEMPERATURE>7.36366126149536</TEMPERATURE>
<SALINITY>35</SALINITY>
<SOUNDVELOCITY>1480</SOUNDVELOCITY>
</PROFILE>
<PROFILE>
<DEPTH>100</DEPTH>
<TEMPERATURE>7.36366126149536</TEMPERATURE>
<SALINITY>35</SALINITY>
<SOUNDVELOCITY>1500</SOUNDVELOCITY>
</PROFILE>
</SOUNDSPEEDPROFILE>
<SOUNDSPEEDPROFILE>
<START>4500</START>
<STOP>9500</STOP>
<PROFILE>
<DEPTH>35</DEPTH>
<SOUNDVELOCITY>1497</SOUNDVELOCITY>
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</PROFILE>
<PROFILE>
<DEPTH>55</DEPTH>
<SOUNDVELOCITY>1499</SOUNDVELOCITY>
</PROFILE>
<PROFILE>
<DEPTH>75</DEPTH>
<SOUNDVELOCITY>1500</SOUNDVELOCITY>
</PROFILE>
</SOUNDSPEEDPROFILE>
</SOUNDSPEEDFILE>

A.4

Volume Back Scatter XML format

<?xml version="1.0" encoding="utf-8"?>
<VOLUMEBACKSCATTERFILE xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<FILEINFO>
<FORMATVERSION>3.00</FORMATVERSION>
</FILEINFO>
<VOLUMEBACKSCATTER>
<START>0</START>
<STOP>500</STOP>
<SCATTERDENOM>DB</SCATTERDENOM>
<VOLUMESCATTER>
<DEPTH>0</DEPTH>
<SCATTER>-96</SCATTER>
</VOLUMESCATTER>
<VOLUMESCATTER>
<DEPTH>23</DEPTH>
<SCATTER>-97</SCATTER>
</VOLUMESCATTER>
</VOLUMEBACKSCATTER>
<VOLUMEBACKSCATTER>
<START>7000</START>
<STOP>10000</STOP>
<SCATTERDENOM>DB</SCATTERDENOM>
<VOLUMESCATTER>
<DEPTH>10</DEPTH>
<SCATTER>-91</SCATTER>
</VOLUMESCATTER>
<VOLUMESCATTER>
<DEPTH>50</DEPTH>
<SCATTER>-92</SCATTER>
</VOLUMESCATTER>
<VOLUMESCATTER>
<DEPTH>80</DEPTH>
<SCATTER>-94</SCATTER>
</VOLUMESCATTER>
</VOLUMEBACKSCATTER>
</VOLUMEBACKSCATTERFILE>
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A.5

Bottom Profile XML format

<?xml version="1.0" encoding="utf-8"?>
<BOTTOMFILE xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<FILEINFO>
<FORMATVERSION>3.00</FORMATVERSION>
</FILEINFO>
<BOTTOMPROFILE>
<RANGE>0</RANGE>
<DEPTH>280</DEPTH>
</BOTTOMPROFILE>
<BOTTOMPROFILE>
<RANGE>943.66200268268585</RANGE>
<DEPTH>275.23809671401978</DEPTH>
</BOTTOMPROFILE>
<BOTTOMPROFILE>
<RANGE>2281.6900908946991</RANGE>
<DEPTH>252.3809552192688</DEPTH>
</BOTTOMPROFILE>
<BOTTOMPROFILE>
<RANGE>3661.9716882705688</RANGE>
<DEPTH>280.0000011920929</DEPTH>
</BOTTOMPROFILE>
<BOTTOMPROFILE>
<RANGE>5436.6195201873779</RANGE>
<DEPTH>280.0000011920929</DEPTH>
</BOTTOMPROFILE>
<BOTTOMPROFILE>
<RANGE>6352.112889289856</RANGE>
<DEPTH>252.3809552192688</DEPTH>
</BOTTOMPROFILE>
<BOTTOMPROFILE>
<RANGE>7309.8593950271606</RANGE>
<DEPTH>250.47619342803955</DEPTH>
</BOTTOMPROFILE>
<BOTTOMPROFILE>
<RANGE>7929.5772314071655</RANGE>
<DEPTH>282.85714387893677</DEPTH>
</BOTTOMPROFILE>
<BOTTOMPROFILE>
<RANGE>8633.80253314972</RANGE>
<DEPTH>288.57142925262451</DEPTH>
</BOTTOMPROFILE>
<BOTTOMPROFILE>
<RANGE>9098.5918045043945</RANGE>
<DEPTH>264.76190686225891</DEPTH>
</BOTTOMPROFILE>
</BOTTOMFILE>

A.6

Bottom Type XML format

<?xml version="1.0" encoding="utf-8"?>
<BOTTOMTYPEFILE xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<FILEINFO>
<FORMATVERSION>3.00</FORMATVERSION>
</FILEINFO>
<BOTTOMTYPE>
<START>0</START>
<STOP>300</STOP>
<TYPE>4</TYPE>
</BOTTOMTYPE>
<BOTTOMTYPE>
<START>300</START>
<STOP>4300</STOP>
<TYPE>6</TYPE>
</BOTTOMTYPE>
<BOTTOMTYPE>
<START>5300</START>
<STOP>10000</STOP>
<TYPE>5</TYPE>
</BOTTOMTYPE>
</BOTTOMTYPEFILE>
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A.7

Bottom Back Scatter XML format

<?xml version="1.0" encoding="utf-8"?>
<BOTTOMBACKSCATTERINGFILE xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<FILEINFO>
<FORMATVERSION>3.00</FORMATVERSION>
</FILEINFO>
<BOTTOMBACKSCATTERING>
<START>0</START>
<STOP>5000</STOP>
<ANGLEDENOM>DEG</ANGLEDENOM>
<SCATTERDENOM>DB</SCATTERDENOM>
<BOTTOMSCATTER>
<ANGLE>0</ANGLE>
<SCATTER>40</SCATTER>
</BOTTOMSCATTER>
<BOTTOMSCATTER>
<ANGLE>50</ANGLE>
<SCATTER>42</SCATTER>
</BOTTOMSCATTER>
</BOTTOMBACKSCATTERING>
<BOTTOMBACKSCATTERING>
<START>5000</START>
<STOP>10000</STOP>
<ANGLEDENOM>DEG</ANGLEDENOM>
<SCATTERDENOM>DB</SCATTERDENOM>
<BOTTOMSCATTER>
<ANGLE>0</ANGLE>
<SCATTER>46</SCATTER>
</BOTTOMSCATTER>
<BOTTOMSCATTER>
<ANGLE>77</ANGLE>
<SCATTER>41</SCATTER>
</BOTTOMSCATTER>
<BOTTOMSCATTER>
<ANGLE>80</ANGLE>
<SCATTER>40</SCATTER>
</BOTTOMSCATTER>
</BOTTOMBACKSCATTERING>
</BOTTOMBACKSCATTERINGFILE>

A.8

Bottom Loss XML format

<?xml version="1.0" encoding="utf-8"?>
<BOTTOMLOSSFILE xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<FILEINFO>
<FORMATVERSION>3.00</FORMATVERSION>
</FILEINFO>
<BOTTOMLOSS>
<START>100</START>
<STOP>3000</STOP>
<ANGLEDENOM>DEG</ANGLEDENOM>
<LOSSDENOM>DB</LOSSDENOM>
<VALUE>
<ANGLE>0</ANGLE>
<LOSS>22</LOSS>
</VALUE>
<VALUE>
<ANGLE>22</ANGLE>
<LOSS>33</LOSS>
</VALUE>
<VALUE>
<ANGLE>45</ANGLE>
<LOSS>40</LOSS>
</VALUE>
</BOTTOMLOSS>
<BOTTOMLOSS>
<START>3500</START>
<STOP>8000</STOP>
<ANGLEDENOM>DEG</ANGLEDENOM>
<LOSSDENOM>DB</LOSSDENOM>
<VALUE>
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<ANGLE>0</ANGLE>
<LOSS>40</LOSS>
</VALUE>
<VALUE>
<ANGLE>24</ANGLE>
<LOSS>37</LOSS>
</VALUE>
</BOTTOMLOSS>
</BOTTOMLOSSFILE>

A.9

Reverberation and noise XML format

<?xml version="1.0" encoding="utf-8"?>
<REVANDNOISEFILE xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<FILEINFO>
<FORMATVERSION>3.00</FORMATVERSION>
</FILEINFO>
<REVERBERATIONANDNOISE>
<RANGE>0</RANGE>
<VALUE>80</VALUE>
</REVERBERATIONANDNOISE>
<REVERBERATIONANDNOISE>
<RANGE>1000</RANGE>
<VALUE>80</VALUE>
</REVERBERATIONANDNOISE>
<REVERBERATIONANDNOISE>
<RANGE>2000</RANGE>
<VALUE>77</VALUE>
</REVERBERATIONANDNOISE>
<REVERBERATIONANDNOISE>
<RANGE>8000</RANGE>
<VALUE>54</VALUE>
</REVERBERATIONANDNOISE>
</REVANDNOISEFILE>
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Appendix B

Compiling NATO VELO message

LYBIN 6.0 has an add-on for compiling NATO VELO messages according to the specification
given in the ATP-32 rev. D [6]. If the add-on is installed, a menu option named "NATO
RESTRICTED" will appear in the LYBIN 6.0 file menu bar. By selecting "Message" in the list
given by clicking the "NATO RESTRICTED" option, a new window called "NATO Bathy
Message Creator" will appear.
The NATO Bathy Message Creator will create a formatted VELO CODE message of the selected
sound velocity profile. It is thus important that the profile originate from a sound velocity probe.
ATP-32 rev. D only includes VELO CODE, and the BATHY CODE given in ATP-32 rev. C is
thus not included. Future development of LYBIN has BATHY CODE as a highly prioritized
feature.

Figure B.1 Graphical user interface of NATO Bathy Message Creator. The left side contains
parameters the user can alter, while the right side continuously shows the resulting
message.
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The user has to enter the sender information, and select or enter the receivers for the VELO.
There are some entries in the catalog by default, but any new receivers will be stored in the
catalog for later use.
The user may also enter time and location information manually. If the probe data has not been
used in calculations by LYBIN, the time and location information from the probe is automatically
extracted. LYBIN removes these data during calculations, so the user has to enter them manually
if calculations have been performed.
In case there are multiple profiles loaded into LYBIN, the user can select the desired profile by
using the "Selected profile" control.
The resulting message can be saved to a regular text file, or printed directly on paper, by clicking
either the "Save" or "Print" button.
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Abbreviations
COM
EDF
FFI
GUI
LYBIN
NDLO/FLO
XML
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Component Object Model
Exported Data Format
Norwegian Defence Research Establishment
Graphical User Interface
LYdBane og INtensitetsprogram (acoustic model)
Norwegian Defence Logistic Organization
Extensible Markup Language
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